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This is a wise choice, after using our Analytics-Con-301 training materials, you will realize your dream of a promotion because you
deserve these reports and your efforts will be your best proof. Therefore, when you are ready to review the exam, you can fully trust
our products, choose our learning materials. If you don't want to miss out on such a good opportunity, buy it quickly. Thus, users do
not have to worry about such trivial issues as typesetting and proofreading, just focus on spending the most practice to use our
Analytics-Con-301 Learning Materials. After careful preparation, I believe you will be able to pass the exam.

Salesforce Analytics-Con-301 Exam Syllabus Topics:

Topic Details

Topic 1

Business Consulting: For Tableau Consultants, this section involves designing and troubleshooting
calculations and workbooks to meet advanced analytical use cases. It covers selecting appropriate chart
types, applying Tableau’s order of operations in calculations, building interactivity into dashboards, and
optimizing workbook performance by resolving resource-intensive queries and other design-related issues.

Topic 2

Data Analysis: This domain targets Tableau Consultants to plan and prepare data connections effectively. It
includes recommending data transformation strategies, designing row-level security (RLS) data structures,
and implementing advanced data connections such as Web Data Connectors and Tableau Bridge. Skills in
specifying granularity and aggregation strategies for data sources across Tableau products are emphasized.

Topic 3

Data Visualization: This section evaluates the Tableau Consultant’s ability to design effective visual analytics
solutions. It involves creating dashboards and visual reports that enhance user understanding, employing
techniques like dynamic actions and advanced chart types, and ensuring performance optimization for an
interactive user experience.
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Topic 4

Data Management: This part focuses on establishing governance and support for published content.
Tableau Consultants are expected to manage data security, publish and maintain data sources and
workbooks, and oversee content access. It includes applying governance best practices, using metadata
APIs, and supporting administration functions to maintain data integrity and accessibility.

Topic 5

IT Management: This domain measures skills related to managing Tableau environments. It includes
planning server upgrades, recommending deployment solutions (on-premise or cloud), and ensuring
alignment between technical and business requirements for analytics infrastructure. It also involves
troubleshooting and optimizing system performance relevant to Tableau Server and Cloud deployments.

>> Analytics-Con-301 Cheap Dumps <<

Analytics-Con-301 Exam Materials Preparation Torrent - Analytics-Con-301
Learning Prep - PDFDumps
Candidates who are preparing for the Salesforce exam suffer greatly in their search for preparation material. You won't need
anything else if you prepare for the exam with our Salesforce Analytics-Con-301 Exam Questions. Our experts have prepared
Salesforce Certified Tableau Consultant with dumps questions that will eliminate your chances of failing the exam.

Salesforce Certified Tableau Consultant Sample Questions (Q29-Q34):
NEW QUESTION # 29 
SIMULATION
Refer to the exhibit.
From the desktop, open the NYC
Property Transactions workbook.
You need to record the performance of
the Property Transactions dashboard in
the NYC Property Transactions.twbx
workbook. Ensure that you start the
recording as soon as you open the
workbook. Open the Property
Transactions dashboard, reset the filters
on the dashboard to show all values, and
stop the recording. Save the recording in
C:\CC\Data\.
Create a new worksheet in the
performance recording. In the worksheet,
create a bar chart to show the elapsed
time of each command name by
worksheet, to show how each sheet in
the Property Transactions dashboard
contributes to the overall load time.
From the File menu in Tableau Desktop,
click Save. Save the performance
recording in C:\CC\Data\.

Answer:

Explanation:
See the complete Steps below in Explanation
Explanation:
To record the performance of the Property Transactions dashboard in the NYC Property Transactions.twbx workbook and analyze
it using a bar chart, follow these detailed steps:
Open the NYC Property Transactions Workbook:
From the desktop, double-click the NYC Property Transactions.twbx workbook to open it in Tableau Desktop.
Start Performance Recording:
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Before doing anything else, navigate to the 'Help' menu in Tableau Desktop.
Select 'Settings and Performance', then choose 'Start Performance Recording'.
Open the Property Transactions Dashboard and Reset Filters:
Navigate to the Property Transactions dashboard within the workbook.
Reset all filters to show all values. This usually involves selecting the dropdown on each filter and choosing 'All' or using a 'Reset'
button if available.
Stop the Performance Recording:
Go back to the 'Help' menu.
Choose 'Settings and Performance', then select 'Stop Performance Recording'.
Tableau will automatically open a new tab displaying the performance recording results.
Save the Performance Recording:
In the performance recording results tab, go to the 'File' menu.
Click 'Save As' and navigate to the C:\CC\Data\ directory.
Save the file, ensuring it is stored in the desired location.
Create a New Worksheet for Performance Analysis:
Return to the NYC Property Transactions workbook and create a new worksheet by clicking on the 'New Worksheet' icon.
Drag the 'Command Name' field to the Columns shelf.
Drag the 'Elapsed Time' field to the Rows shelf.
Ensure that the 'Worksheet' field is also included in the analysis to break down the time by individual sheets within the dashboard.
Choose 'Bar Chart' from the 'Show Me' options to display the data as a bar chart.
Customize and Finalize the Bar Chart:
Adjust the axes and labels to clearly display the information.
Format the chart to enhance readability, applying color coding or sorting as needed to emphasize sheets with longer load times.
Save Your Work:
Once the new worksheet and the performance recording are complete, ensure all work is saved.
Navigate to the 'File' menu and click 'Save', confirming that changes are stored in the workbook.
References:
Tableau Help Documentation: Provides guidance on how to start and stop performance recordings and analyze them.
Tableau Visualization Techniques: Offers tips on creating effective bar charts for performance data.
By following these steps, you have successfully recorded and analyzed the performance of the Property Transactions dashboard,
providing valuable insights into how each component of the dashboard contributes to the overall load time. This analysis is crucial for
optimizing dashboard performance and ensuring efficient data visualization.

NEW QUESTION # 30 
A client requests a published Tableau data source that is connected to SQL Server. The client needs to leverage the multiple tables
option to create an extract. The extract will include partial data from the SQL Server data source.
Which action will reduce the amount of data in the extract?

A. Set up the extract as an incremental refresh.
B. Aggregate the extract to the visible dimensions.
C. Define the filters by using custom SQL.
D. Use an extract filter.

Answer: D

Explanation:
Using an extract filter is an effective way to reduce the amount of data in a Tableau extract. Extract filters allow you to specify a
subset of the data to include, which can significantly decrease the size of the extract by excluding unnecessary data. This is
particularly useful when you only need partial data from a larger SQL Server data source.
References: The recommendation to use extract filters to reduce data size is supported by Tableau's best practices for optimizing
extracts. These practices suggest keeping the extract's data set short through filtering1. Additionally, discussions in the Tableau
Community confirm that hiding fields and using extract filters before extracting data can help reduce the extract size2.
When dealing with large datasets in SQL Server and needing to create a manageable extract in Tableau, using an extract filter is the
most direct and effective method to limit the data included:
Extract Filter: This involves setting filters that apply directly when the data is extracted from the source. This means that only the data
meeting the specified criteria will be extracted and loaded into Tableau, significantly reducing the size of the extract.
To apply an extract filter, in the Data Source page in Tableau, drag the fields you want to filter by to the Filters shelf. Then, configure
the desired filter criteria. When you create the extract, choose the option to "Add Filters to Extract" and select the configured filters.
This ensures that only the data that meets these conditions is extracted from the SQL Server.
This approach not only minimizes the data volume but also speeds up performance in Tableau because it processes a smaller subset



of the full dataset.
References
This procedure is described in detail in Tableau's help documentation on managing extracts and optimizing performance by using
extract filters, which is recommended for scenarios involving large datasets or when specific subsets of data are required for analysis.

NEW QUESTION # 31 
An online sales company has a table data source that contains Order Date. Products ship on the first day of each month for all
orders from the previous month.
The consultant needs to know the average number of days that a customer must wait before a product is shipped.
Which calculation should the consultant use?

A. Calc1: DATETRUNC ('month', DATEADD('month', 1, [Order Date]))
Calc2: AVG(DATEDIFF ('week', [Order Date], [Calc1]))
B. Calc1: DATETRUNC ('month', DATEADD ('month', 1, [Order Date]))
Calc2: AVG(DATEDIFF ('day', [Order Date], [Calc1]))
C. Calc1: DATETRUNC ('day', DATEADD('week', 4, [Order Date]))
Calc2: AVG([Order Date] - [Calc1])
D. Calc1: DATETRUNC ('day', DATEADD ('day', 31, [Order Date]))
Calc2: AVG ([Order Date] - [Calc1])

Answer: B

Explanation:
The correct calculation to determine the average number of days a customer must wait before a product is shipped is to first find the
shipping date, which is the first day of the following month after the order date. This is done using DATETRUNC('month',
DATEADD('month', 1, [Order Date])). Then, the average difference in days between the order date and the shipping date is
calculated using AVG(DATEDIFF('day', [Order Date], [Calc1])). This approach ensures that the average wait time is calculated in
days, which is the most precise measure for this scenario.
References: The solution is based on Tableau's date functions and their use in calculating differences between dates, which are well-
documented in Tableau's official learning resources and consultant documents12.
To calculate the average waiting days from order placement to shipping, where shipping occurs on the first day of the following
month:
Calculate Shipping Date (Calc1): Use the DATEADD function to add one month to the order date, then apply DATETRUNC to
truncate this date to the first day of that month. This represents the shipping date for each order.
Calculate Average Wait Time (Calc2): Use DATEDIFF to calculate the difference in days between the original order date and the
calculated shipping date (Calc1). Then, use AVG to average these differences across all orders, giving the average number of days
customers wait before their products are shipped.
References:
Date Functions in Tableau: Functions like DATEADD, DATETRUNC, and DATEDIFF are used to manipulate and calculate
differences between dates, crucial for creating metrics that depend on time intervals, such as customer wait times in this scenario.

NEW QUESTION # 32 
In what way does View Acceleration improve performance?

A. By enhancing the rendering speed of visuals, such as drawing shapes and maps
B. By optimizing the performance of views built only on extract-based data sources
C. By precompiling and fetching workbook data in a background process
D. By improving the performance of views that contain long-running queries with transient functions

Answer: C

Explanation:
Comprehensive and Detailed Explanation From Exact Extract:
View Acceleration is a Tableau Server and Tableau Cloud feature that speeds up slow-loading views by precomputing their queries
in the background.
According to Tableau's server and cloud performance documentation:
* When View Acceleration is enabled for a view, Tableau runs the queries behind that view on a background process and stores the
results in memory.
* When an end user later opens the view, Tableau can serve the precomputed results immediately, rather than running the potentially



long-running queries at that moment.
* This improves initial load time significantly for views that are slow because of heavy queries.
It does not only work with extract-based data sources (it can also help with many live connections), so option A is too limited.
It does not change the client-side rendering engine, so option C is incorrect.
It is not specific to transient functions but to any view where the query is expensive, so option D is not accurate.
Therefore, the correct description is that View Acceleration precompiles and fetches workbook data in a background process,
which matches option B.
* Tableau Server and Tableau Cloud help describing View Acceleration as precomputing and caching view results using background
processes.
* Performance tuning guidance recommending View Acceleration for views with slow query execution.

NEW QUESTION # 33 
A client wants to count all the distinct orders placed in 2010. They have written the following calculation, but the result is incorrect.
IF YEAR([Date])=2010 THEN COUNTD ([OrderID]) END
Which calculation will produce the correct result?

A. COUNT(IF YEAR([Date])=2010 THEN [OrderID] END)
B. IF YEAR([Date])=2010 THEN {COUNTD ([OrderID])} END
C. COUNTD(IF YEAR([Date])=2010 THEN [OrderID] END)
D. IF MIN(YEAR([Date]))=2010 THEN WINDOW_COUNTD([OrderID]) END

Answer: C

Explanation:
The correct calculation to count all distinct orders placed in 2010 involves placing the conditional inside the aggregation function, not
the other way around. Here's how to correct the client's calculation:
Original Calculation Issue: The client's original calculation attempts to apply the COUNTD function within an IF statement, which
does not work as expected because the COUNTD function cannot conditionally count within the scope of the IF statement.
Correct Calculation: COUNTD(IF YEAR([Date]) = 2010 THEN [OrderID] END). This calculation checks each order date; if the
year is 2010, it returns the OrderID. The COUNTD function then counts all unique OrderIDs that meet this condition.
Why It Works: This method ensures that each order is first checked for the year condition before being counted, effectively filtering
and counting in one step. It efficiently processes the data by focusing the distinct count operation only on relevant records.
References
This approach is consistent with Tableau's guidance on using conditional logic inside aggregation functions for accurate and efficient
data calculations, as detailed in the Tableau User Guide under "Aggregations and Calculations".

NEW QUESTION # 34
......

When looking for a job, of course, a lot of companies what the personnel managers will ask applicants that have you get the
Analytics-Con-301 certification to prove their abilities, therefore, we need to use other ways to testify our knowledge we get when
we study at college , such as get the Analytics-Con-301 Test Prep to obtained the qualification certificate to show their own all
aspects of the comprehensive abilities, and the Analytics-Con-301 exam guide can help you in a very short period of time to prove
yourself perfectly and efficiently.
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